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1 Introduction 

1.1 The birth of ARP Instruments and the ARP2600  

Alan R. Pearlman, whose initials would form the name of ARP Instruments, became interested in 
instruments for electronic music as early as 1948, when he was a student at the Worcester Poly-
technic Institute. This was a means for him to associate his two passions: electronic music and the 
piano.  

It was by commercializing the amplifier models for the NASA Gemini and Apollo programs that he 
would start his career. Around 1968 he started seriously imagining the possibility of building elec-
tronic instruments – after hearing a recording of “Switched-on Bach,” according to legend.  

In 1969, Alan R. Pearlman, David Friend and Lewis G. Pollock created ARP Instruments (originally 
called Tonus Inc.).  The company, based in Newton Highlands (Massachusetts, USA), conceived elec-
tronic products, but also and above all else a large modular synthesizer, the ARP 2500. The machine 
used a matrix which connected the different sections of the synthesizer, instead of the traditional 
cables found in the Moog Modulars. The ARP 2500 found success in American universities. 

The growth of ARP instruments was fast and in 1972 the ARP 2600, probably the most legendary of 
the entire range, was unveiled. This semi-modular synthesizer, conceived with an educational goal, 
was to become hugely successful after a shaky start. The ARP 2600 was notably used by Stevie Won-
der, Joe Zawinul (Weather Report), Tony Banks (Genesis), Jean-Michel Jarre, Herbie Hancock...  
ARP was the market leader in synthesizers during the 70’s with around 40% of the market share. 

In ten years, three versions of the ARP 2600 were commercialized:  The first version was called 
“Blue meanie” because of its steely blue finish. The “blue meanie” was quickly replaced by a sec-
ond version, with a grey background finish and white silk screening (1972). This was to be more 
popular. In 1978 ARP decided to change the graphic chart for all of its machines: a black background 
color with orange silk screening was introduced. The ARP2600 benefited from its third and last ver-
sion.  

The great rival of ARP was Moog Music. The competition between the two manufacturers can easily 
be seen when we observe the machines: The ARP, for example, has linear potentiometers, while the 
Moog has rotating pitch bend and modulation wheels.  

A well known episode of this competition was the 24 dB/octave filter, the 4012, used by the ARP. 
This was a replica of the famous Moog filter. In 1973, Moog threatened ARP with legal action and 
the firm decided to change the circuits on its filter. The 4072 was born and took the place of the 
4012. This possessed a calibration error in the high frequencies – the maximum cut-off frequency 
was less than 11 kHz instead of the 16 kHz promised in the press. Luckily the repair for users was 
fast and not much of a burden. On the first ARP 2600’s, the 4012 filter was still used (this was the 
case for the “Blue meanie” and on the first examples of the “grey and white”) while the models 
that followed offered the 4072.  

The ARP synthesizers possess very stable oscillators, more reliable than the Moog synthesizers (a 
fact admitted by Robert Moog himself). On the other hand, ARP for a long time dipped the elec-
tronic circuits for filtering in resin to avoid industrial piracy... this made for major problems when 
trying to perform a repair. 

In 1972, ARP launched the Odyssey, which would be in direct competition with Moog Music and their 
Minimoog released one year earlier. The same year, the Pro-Soloist, a preset instrument, was also 
unveiled.  

In 1976, ARP released a small 16 step sequencer in the form of 2 independent 8 step sequences. 
This became famous and is still very sought after (it is emulated in the ARP2600 V.) The same year 
they presented the Omni, which would become one of ARPs biggest successes. The instrument al-
lowed the combination of two polyphonic violin sounds – a great innovation for the company – and 2 
monophonic bass sounds.  

In 1976, ARP released a small 16-step sequencer in the form of two independent 8-step sequences. 
This became famous and is still very sought after (it is emulated in the ARP2600 V.) The same year 
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they presented the Omni, which would become one of ARPs biggest successes. The instrument al-
lowed the combination of two polyphonic violin sounds – a great innovation for the company – and 
two monophonic bass sounds.  

But in 1981, ARP was finally bought out by CBS. The following year, CBS with part of the ARP devel-
opment team would produce the Chroma, a programmable polyphonic synthesizer, and in 1984 the 
Chroma Polaris, a simplified and MIDI-capable version of the Chroma.  

1.2 A better emulation thanks to TAE® 

 

TAE® - True Analog Emulation - is a new technology dedicated to the digital reproduction of analog 
circuits used in vintage synthesizers. 

When implemented in software code, TAE’s algorithms guarantee authentic emulation of hardware 
specifications. This is why your ARP2600 V offers an unparalleled quality of sound.  

In detail, TAE® combines four major advances in the domain of synthesis: 

1.2.1 Aliasing-free oscillators 

 

Standard digital synthesizers produce aliasing in high frequencies, and also when using Pulse Width 
Modulation or FM. 

TAE® allows the production of totally aliasing-free oscillators in all contexts (PWM, FM…), and at no 
extra CPU cost.  
 

 

 

Linear frequency spectrum of an existing well-known software synthesizer 
 

 

Aliasing 
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Linear frequency spectrum of the ARP2600 V oscillator made with TAE 
 

1.2.2 A better reproduction of analog oscillator waveforms 

 

The waveforms produced by the oscillators in analog synthesizers are marked by the presence of a 
capacitor in the circuits. The discharge of the capacitor results in a light bend in the original wave-
form (notably for saw tooth, triangular and square waveforms). TAE allows the reproduction of this 
capacitor discharge. Underneath is the analysis of a waveform from the original ARP2600, and that 
of the ARP2600 V. They are both equally deformed by the ARP2600 V low-pass and high—pass filter-
ing. 

 

 

Temporal representation of a “saw tooth” waveform of the original ARP2600  
 

 

 

Temporal representation of an ARP2600 V “saw tooth” waveform reproduced by TAE 
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What’s more, the original analog oscillators were unstable. In fact, their waveform varied slightly 
from one period to another. If we add to this the fact that the starting point for each period (in 
Trigger mode) can vary with the temperature and other environmental conditions, we find one of 
the characteristics that contributed to the typical sound of vintage synthesizers.  

TAE reproduces the instability of oscillators, bringing a fatter and “bigger” sound.  

1.2.3 A better reproduction of analog filters 

 

TAE allows more precise emulation of analog filters than standard digital filters. To obtain this re-
sult, the TAE technology is based on the analysis of the analog circuits to be reproduced, and con-
verts them into algorithms that faithfully mimic the characteristics of the original filters. The curve 
underneath shows the comparison of the original ARP2600 filter and that of the ARP2600 V. 

 

 

Response curve of the 12 dB low-pass filter of the original ARP2600 V and the ARP2600 V 

1.2.4 Ring modulator 

 

The ARP2600 V includes a ring modulator, just like the original ARP2600. The ring modulator allows 
the application of a waveform (a sinusoid) to another, in order to transform it. The result is a more 
brilliant sound, distorted, and enriched in harmonics. As a result of this increase in the number of 
harmonics, standard ring modulation algorithms create an audible aliasing. To avoid this unwanted 
effect, TAE includes a module for the dynamic control of the amplitude with aliasing correction, 
which removes every trace of aliasing in the signal coming from the ring modulator. 

 

 

 

 

 

 

Response curve of the 12
dB low-pass filter of the
original ARP2600  
 
 
 
 
Response curve of the 12
dB low-pass filter of the
ARP2600 V 
 
 
 

Amplitude control module (VCA)
with aliasing correction 

Input Output 

Sine wave 
form 
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2 Installation 

2.1 Windows installation (Win9x, Me, 2000, XP) 

� Insert the CD-ROM into the drive. Explore the contents of the CD-ROM, and double-click on the 
icon named “ARP2600V Setup PC.exe” 

 

First you will need to define an installation folder for the program. By default it will be installed in 
C:\Program Files\Arturia\ARP2600V. You can change this location with the Browse button. 

Next, have your license number ready and enter it along with your first and last name in the user 
information window. 

 

 

User information window 

The ARP 2600V will firstly be installed as a stand-alone program. The following step will give you 
the choice of configuring it as a plug-in as well. You will be asked to define the protocol(s) that you 
use (VST, RTAS, HTDM, DXI). For more information on these protocols please see Chapter 7. 

For the VST and RTAS protocols, you will be asked to choose an installation folder so that the host 
application may use it as a plug-in. If you are not sure how to make this choice, please see Chapter 
7. 
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Choice of installation folder for SVT plug-in 

The installation program now has enough information to finish the procedure. In a few seconds, you 
will be using the ARP2600 V. 

2.2  Mac OS X installation 

Insert the CD-ROM into the drive. Explore the contents of the CD-ROM, and double click on the icon 
named “ARP2600V Setup Mac”. 

Enter your administrator name and password in the authentication window. 

The ARP2600 V will firstly be installed as a stand-alone program. By default, all the protocols (VST, 
RTAS, HTDM). will be directly installed on you computer. For more information on these protocols 
please see Chapter 7. 

The ARP2600 V will be installed in your applications folder. You can also define a different drive and 
installation folder. 

Next, have your license number ready and enter it along with your name and family name in the 
user information window. The installation program now has enough information to finish the proce-
dure. In a few seconds, you will be using the ARP2600 V. 

 

Enter your license number, then your first and last name 
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3 Quick start 

This chapter will help you to familiarize yourself with the general basics of using the ARP2600 V. A 
summary of the different parts of the synthesizer will be presented to you as we guide you through 
your first use of the program. You will find a detailed and precise description of all settings and 
controllers in the following chapters. 

Chapter 7, A few elements of sound design, is highly recommended for users who have never 
worked with a subtractive synthesizer and who wish to become familiar with the fundamentals in 
this domain. 

 

Overview of the ARP 2600V 
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3.1 Using presets 

The use of presets is one of the biggest improvements of the ARP2600 V compared to the original. In 
fact, the latter was unable to save sounds!  

In the ARP2600 V, a preset contains all of the parameter settings of the synthesizer, including the 
synthesizer and different real-time controllers (eg: velocity, aftertouch, pitch-bend) as well as the 
effects (delay, chorus) needed to reproduce a sound.  

To get to know the different sounds contained in the ARP2600 V, we will use the preset “Bass1” 
situated in the “JMBlanchet” / “Basses” bank. 

� For this, click on the button above the “BANK” LCD display indicating “Factory” (this screen 
presents the name of the current bank). By clicking here you will see a menu appear containing 
the list of available banks. Choose the bank “JM_Blanchet” (the bank name is checked) . 

When this menu is open, sub menus can be accessed (in the fashion of a drop-down menu). This 
system lets us access the “SUB BANK” and “PRESETS” for a sound designer with a single click.  

� Choose the “SUB BANK” “Basses” and select “JMB_bass1” among the “PRESETS”. 
 

 

Select the preset JMB_bass1 

The ARP2600 V ships with more than 300 presets that will help you to get to know the sounds of the 
synthesizer. A bank named “User / Temp” offers a selection of template presets for beginning the 
programming of a sound (the sound “1_Osc”, for example, comes with: an oscillator directed to the 
low-pass filter, and then routed towards the VCA). 

3.1.1 Now modify a preset 

For this, we will start with a very simple manipulation.  

� Modify the brightness of the sound “JMB_Simple1” with the linear “Initial Cutoff Frequency” 
potentiometer of the filter. Raise or lower the potentiometer and notice the sound become 
more or less “bright”. Set this potentiometer to a pleasing value. 

It is also possible to visualize the entirety of the presets corresponding to a type of sub bank by 
selecting the option “All” in the bank. For example, to see all of the bass presets, click on “All” in 
the bank selection and then on “Bass”. 
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Change the brightness of the sound 

� In the same manner, you can change the range of oscillator 1 by setting the “Range” selector to 
one of the values expressed in steps: LF = low frequencies, 32’ = -2 octaves, 16’ = -1 octave, 8’ 
= standard tuning, and 4’ = + 1 octave.  

 

 

Setting the range of oscillator1 

By performing these first settings, you have already modified the preset “JMB_Simple1”. You will 
now see how to save the sound that you have created. 

� To choose another destination for the sound, click on the “Save as” icon and choose the loca-
tion. For example select “new” in the choice of bank. Two new banks, sub banks and a preset 
are immediately created. The names “new bank”, “new sub bank…” and “new preset…” appear 
in their respective displays.  

� Click on each of these displays to rename the 3 parts. 

 

Saving a preset 

To save a user preset (“Users”), click on the “Save” icon in the toolbar: The new settings will be 
saved in the current preset without changing the name (but if the selected preset is one of the 
“factory” presets, the factory setting will not be overwritten).   

 

Attention! It is important to specify that changing the name of a preset does not create a new one! 
Only the name of the current preset will be changed. 
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3.2 The 3 sections of the ARP2600 V 

The ARP 2600V offers three main sections separated into flight cases: 

From top to bottom: 

The synthesizer, the sequencer / LFO / general settings, and keyboard  

To access the different parts of the ARP2600 V there are two simple methods: 

� Click on a part of the synthesizer that des not have any controllers (potentiometers, switches..) 
or jacks, then slide the mouse towards the top or the bottom without releasing. 

 

Slide the mouse towards the top or bottom 

� Click on one of the three shortcuts ,  and  situated on the toolbar to quickly 
move from one section to another: 

• The  (SYNTHESIZER) section brings you to the synthesizer. 

• The  (SEQUENCER and KEYBOARD) section brings you to the sequencer. 

• The  (“ALL”) section brings you all the interface of the ARP2600 V 
 

 

3.3 Overview of the Synthesizer  

The “SYNTH” section contains 73 synthesis parameters as well as jack inputs and outputs that you 
can connect to one another with virtual cables. The potentiometers or switches associated to these 
parameters will help you to create an infinite variety of sounds.  

These parameters are made up of: 

• Three oscillators (VCO) which release the audio signal through wave forms (triangle, 
sinusoid, saw-tooth, square and rectangle) and which manage the pitch (frequency) 
of the sound. 

• A noise module. 
• A ring modulator 
• A sample / hold module. 
• A mixer acting on the signals coming from the oscillators, noise module and ring 

modulator. 
• A low-pass resonant 24  dB filter and multimode 12 dB (LP, HP, BP and notch) 
• An amplifier (VCA) allowing the amplification of the signal coming from the filter 

and its direction towards the stereo output. 
• Two envelopes (ADSR and AR) modulating the low–pass filters and amplifier. 

If you are in the “All” section, you can resize the window by clicking on the 2 arrows situated on the 
right of the 3 sections shortcuts.  
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Synthesis parameters 

Let’s look at quickly creating an evolving lead sound: 

� To really understand the programming of the ARP2600 V, let’s use a very simple sound. Select 
the preset “1_Osc” in the “Template / Temp_Synth” sub bank. The structure of synthesis for 
this sound is relatively simple: the square wave form oscillator1 is active and the signal is di-
rected through the low-pass filter after an intermediary mixer, and then on to the output ampli-
fier. An ADSR envelope modulates the filter cut-off frequency and a second envelope, AR, 
modulates the volume of the amplifier.  
 
The following block diagram recaps the architecture of the creation of the sound: 

 

 

The routing taken by the sound of preset “1_Osc” 

� Start by reducing the low-pass filter cut-off frequency (LPF). This will dampen the sound.  
For this, set the linear “Initial Cutoff frequency” potentiometer (for fine tuning, use the “Fine 
tune” potentiometer). 
Notice that the filter cut-off frequency is modulated by an ADSR envelope (Attack, Decay, hold - 
Sustain – and Release).  
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Change the brightness of the sound 

� To clearly hear the effect produced by the ADSR envelope on the filter cut-off frequency, in-
crease the resonance value.  This will amplify the filtering effect on the sound and it will begin 
to “whistle”. 

 

 

increase the resonance value 

� Change the attack length of this envelope (“Attack time”) so that the brightness increases 
faster or slower when the note is sent. 

 

 

Change the attack length of the ADSR envelope 
 
� In the same manner, change the value for the decay, and the brightness will increase faster or 

slower while you hold the note on the keyboard. 

 

The “Decay time” parameter on the filter envelope 

Now let’s perform a short modification on the second envelope, the “AR” envelope. 
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� Increase the “Attack time” for this envelope so that the volume of the sound progressively in-
creases.  

 

Increase the “Attack time” of the AR envelope 

3.4 The sequencer  

The “SEQ” section gives you access to the sequencer as well as different functions allowing an ex-
tension of the possibilities of synthesis and playing. It is situated under the “Synth” section. It con-
tains a sequencer identical to the 16 step ARP (model 1601) sequencer, a module for play settings, 
and a low frequency oscillator (LFO) which was added as a complement to oscillator2 which was 
often used as LFO. 

3.4.1 The ARP sequencer 

The ARP sequencer greatly increases the possibilities for sound and melodic creation. It allows you 
to create two simultaneous 8-step melodic lines, or one 16-step line (by putting two 8-step lines in 
a series). It is also possible to modulate any parameter of synthesis through one of the two se-
quencer outputs.   

 

The ARP sequencer 

The ARP sequencer contains 3 parts: 

From left to right: 

• The two lines of faders and selector switches situated at the top give access to the 
tuning of the 16 steps as well as management of their triggering (gates).  
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The two lines of faders and selector switches 

• The oscillator sets the speed of the sequencer as well as the start and stop. 
 

 

set the oscillator speed 

• The “Quantizer” quantifies the values for the 16 steps by semi-tone.  
 

 

the quantizer section 

Let’s take a simple melodic sequence for example: 

� Load the preset “Template”/ “Temp_SEQ”/ “1x16_sequencer” 
 

You will notice that the connexions between the sequencer and synthesizer are already done:  
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the connexions between the sequencer and synthesizer 

� The “Clock Out” sequencer output is directed to the “Gate” input on the ADSR envelope mod-
ule. 

� The sequencer “Quantized A Out” output is directed to input “KBD CV” of the “VCO 1” module. 
� Start the sequencer by clicking on the “Start” button. This “turns” in a loop and you will hear 

the repetition of the melody. 
 

 

click on the “Start” button 

� You can change the settings of the 16 linear potentiometers to create an other melody. 
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Set the 16 linear potentiometers 

3.4.2 The LFO 

On the original ARP 2600, oscillator2 could be set to low frequency position (“LF” position in the 
range) for use in LFO mode. Although practical, this solution prevented us from using 3 oscillators 
simultaneously and a slow modulation on the filter cut-off frequency for example. 

Thanks to the LFO module situated on the “Keyboard  control” module of the “All” mode, you can 
keep the third oscillator as base sound and obtain an additional source of modulation for one of the 
13 available destinations. It is also possible to synchronize the clock speed of the LFO to that of the 
MIDI sequencer by clicking on the “MIDI sync” interrupter. 

Apply two additional types of modulation to the preset “1_Osc”: 

� For example: the LFO is “pre-cabled” to obtain a vibrato (simultaneous frequency modulation) 
of the two oscillators. Simply raise the linear potentiometer “Vibrato Depth”, situated on the 
LFO module, to create this effect.   

 

 

Raise the “Vibrato Depth” potentiometer 

� Another example would be to click on the LFO triangle output and direct the cable to the “VCO2 
sin” modulation input of the filter module. Raise the potentiometer above it. Lower the cut-off 
frequency to hear the result more clearly. The brightness of the sound will vary in a cyclic fash-
ion, to the rhythm of the LFO.  
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Modulate the filter frequency (“Cutoff Frequency”) with the LFO  

 

3.5 The effects  

The effects section lets you add a Stereo Delay and Chorus to your sound on top of the reverbera-
tion which is already present in the original instrument. The two effects can be found in the place 
of the left speaker grid on the synthesizer. 

To open it, click on the “open Effects” button under this grid. 

 

 

Open the effects grid 
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3.5.1 Chorus 

Chorus is used to copy your sound, and slightly detune the copy, to give it more depth and the Cho-
rus “ON/OFF” button in the effects section, on the right of the toolbar. 

� Set the Chorus “Dry/Wet” potentiometer to balance the “raw” sound and the one returning 
from the effect. 

� Next turn the Chorus “Rate” potentiometer to set the speed of the oscillations. 
� Finally set the depth of the chorus using the “Depth” potentiometer. 
 

 

the chorus effect settings 

3.5.2 Delay 

Delay brings a stereo echo effect to bring more space to your sound. 

It possesses independent settings for the speed and number of repetitions for the left and right 
sides. It is also possible to create a large number of rhythmic combinations between the repetitions. 
The delay speed can also be synchronized with the MIDI tempo. 

Let’s keep the preset “JMB_Simple1” and see how to use the effects on this sound: 

� Activate the “Delay” button on the toolbar. The effect becomes active. 
� Set the Delay “Dry/Wet” potentiometer so as to balance the “raw” sound with the one coming 

from the delay. 
� Next turn the two Delay “Speed” potentiometers to set the rate of echo repetitions for the right 

side (Time Right) and left side (Time Left). 
� It is also possible to set the number of repetitions for each side (“Feedb. Right” and “Feedb. 

Left”).  
 

 

The Delay effect settings 

3.6 Real-time controllers and MIDI assign  

Like its brilliant ancestor, the ARP2600 V is particularly adapted to real-time playing. One of the 
main improvements when compared to the original is that we can assign any potentiometer on the 
ARP2600 V to an external MIDI controller.  

Here’s an example of assigning: 

� Click on the “Initial Cutoff frequency” potentiometer of the filter while keeping the Ctrl button 
held down. A MIDI assign dialog appears.  

� Click on “Learn” and then move the MIDI controller of your choice (the modulation wheel for 
example). The ARP2600 V potentiometer will start to move at the same time. 
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� You can then record movements from your MIDI controller on your MIDI sequencer or simply play 
live. 

 

 

MIDI assign for “Cutoff frequency” potentiometer 

To save the settings that we have seen in this chapter, click on the “Save” button in the toolbar. 

 

Attention ! The MIDI assign settings are only saved when you quit the ARP2600 V application – be it 
standalone or plug-in. 



24 ARTURIA – ARP2600 V – USER’S MANUAL 

 



ARTURIA – ARP2600 V – USER’S MANUAL 25 

4 The interface 

4.1 Using the presets 

The presets memorize the ARP2600 V sounds. A preset contains all of the inter-module connections 
and the different controller information necessary for the recreation of an identical sound. In the 
ARP2600 V, presets are classed in “banks” and “sub-banks”. Each bank contains a certain number of 
sub-banks, which determine a type of sound: sub-bank “basses”, sub-bank “sound effects”, etc. 
Each sub-bank contains a certain number of presets. 

The ARP2600 V comes with several “factory” sound banks. It is possible to create new “user” sound 
banks, each containing an arbitrary number of sub-banks and presets. For security, the “factory” 
settings are not directly modifiable. It is, however, possible to modify a sound based on a factory 
preset and to record it to a “user” bank. 

4.1.1 Choice of bank, sub-bank, preset 

The banks, sub-banks and presets being currently used are always displayed in the synthesizer tool-
bar. 

 

display of bank, sub-bank, and preset being used 

To choose a preset in the current sub-bank, click on the button on the left of the current preset, a 
drop-down menu appears with a list of presets from the same sub-bank. You can choose another 
preset in the menu by selecting the corresponding line. Once the preset has been chosen, you can 
play the new sound from your MIDI keyboard or sequencer. 

 

 

choice of preset in the same sub-bank 

To choose a preset in the same main bank, but in a different sub-bank, click on the button on the 
left of the current sub-bank, a drop-down menu will appear with the list of sub-banks contained in 
the same main bank. Each sub-bank in the menu allows you to open a sub-menu containing its pre-
sets. A click on a preset lets you directly choose a preset in the new sub-bank. 

To choose a preset in another main bank, click on the button . A drop-down menu appears with 
the choice of the main banks that are available, and the sub-lists corresponding to the sub-banks 
defined in each main bank and the presets contained in each sub-bank. You can now freely choose a 
preset by clicking on its name. 
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Once a preset has been changed (modification of a controller or connection), an asterisk appears 
next to its name in the tool bar. 

In the “BANK” dropdown menu, the “All” option allows you to open a sub-list with all of the sub-
banks available in all of the banks. This gives you access directly to all of the presets of a given 
type, for example all of the basses, no matter which bank they are in. 

This function is particularly useful to quickly see all of the presets of the same type. 

 

 

the “All” option 

4.1.2 Creation of a bank, sub-bank, preset 

To create a new bank of sounds, click on the button on the left of the current bank. In the drop-
down menu, select “New bank...” to create a new bank of sounds. You can then change the name 
of this bank by clicking on its name in the toolbar and typing the new name. 

To create a new sub-bank, again just click on the button on the left of the current sub-bank, and 
select “New sub bank...”. You can also change the name of the new sub-bank. 

Finally, to create a new preset, click on the button on the left of the name of the current preset 
and select “New preset...”. The new preset is created using the current ARP2600 V settings (con-
trollers and connections). You can then work on the settings of the sound, and save it by clicking on 
the save button (see the next paragraph). You can also change the new preset name by clicking on 
its name. 

4.1.3 Saving a user preset 

To save your current settings under the current preset, click on the “Save” button on the ARP2600 V 
toolbar. 
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 “Save” button on the toolbar 

If you want to save your preset under a different preset name, click on the “Save As” button in the 
toolbar. A drop-down menu will appear allowing the choice of either an existing preset (in this case, 
the preset contents will be replaced by the current setting), or to save your preset as a new preset 
(in this case, click on “New Preset…” in the sub-bank of your choice). 

 

 

“Save As” menu on the toolbar 

� When you are working on a factory preset, which cannot be erased, clicking on the “Save” but-
ton will not replace the current factory setting, but will automatically open the “Save As” func-
tion to save the current setting as a user preset. Click on the “New bank” option. The three LED 
displays indicate “New”: you can click on each of these displays to give it a name or save your 
setting as a new preset (in this case, click on “New preset...” in the sub-bank of your choice). 

 

 

the “New preset...” option 

4.1.4 Importation / Exportation of a preset bank 

It is possible to import new preset banks created for the ARP2600 V. To import a new bank of pre-
sets, click on the preset bank import button in the toolbar: 

 

Preset bank import button on the toolbar 

When you click on this button, a dialog appears allowing the choice of ARP2600 V preset bank files 
(.AMB file type on PC, AMpB file type on Mac). Choose the file that you want to import, and click on 
“Open”. The new preset bank will automatically appear in the available banks. 

The ARP2600 V also offers the option to export your own sound banks to save them, use them on 
another machine, or share them with other users. It is possible to export a preset, a sub-bank, or a 
complete bank. To export a bank, sub-bank, or current preset, click on the export preset bank but-
ton on the toolbar: 
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Current preset bank export button in the toolbar 

Select the type of export that you wish to perform (bank, sub-bank or preset) from the list and a 
window will appear prompting you to choose a destination folder and a name for the file you are 
about to export. 

 

4.2 Use of controllers 

 

4.2.1 Vertical linear potentiometers 

The ARP 2600V mainly uses linear potentiometers. To change the value of a vertical potentiometer, 
click on it and move it vertically to the desired value.  

 

 

linear potentiometer 

4.2.2 Horizontal linear potentiometers 

To move these potentiometers, click on it and slide to the right or left to reach the desired value. 

 

horizontal potentiometer 

4.2.3 Knobs  

 

You can find some knobs among the global settings, by exemple. 

The default mode of control for knobs with the mouse is the linear mode: the knob can be set only 
by vertically moving the mouse. It is possible to obtain a higher precision by right clicking or 
Shift+Click on the knob concerned. 

 

a  knob 
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In circular mode, click on the knob and turn around it in order to change the value of the controller. 
The circular mode gives high precision in the manipulation of controls: The further the mouse goes 
from the knob, the higher the precision of the setting. 

 

4.2.4 The selectors:  

The selectors (the filter mode selector for example) are manipulated like vertical potentiometers 
by dragging with the mouse). 

 

The filter “Modes” selector 

4.2.5 Switches  

The ARP2600 V has several types of switches. Simply click on these switches to change their state. 

 

MIDI sync on/off switch 

4.2.6 Pitch Bend 

The pitch bend knob is used to change the pitch of the oscillators. Just click on the knob and move 
the mouse up or down to change the pitch of your sound. The knob goes back to the center position 
when the mouse is released. 

 

The pitch bend knob 

 

4.3 Using cables 

The connection of different modules (Oscillators, Filter, VCA...) to one another broadens the possi-
bilities for sound design. The ARP2600 V owes its extraordinary possibilities for creation in a large 
part to the wide range of connections possible. On the original ARP 2600, all of the connections 
were done by two types of cables: 

The linear mode is often more simple to use than rotation. But at the same time it cam be less pre-
cise (the precision is limited by the number of vertical pixels on the screen from which the mouse 
movements are evaluated). It is possible to attain a higher level of precision by right-clicking, or 
shift-click, on the potentiometer you want to control. 
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4.3.1 Audio and modulation connections 

The audio connections can be used, for example, to route the audio output of a wave form from an 
oscillator to the audio input of the filter or VCA mixer. In the same manner, the modulation connec-
tions allow you to route the output of a LFO or envelope generator to an oscillator PWM or the VCA 
modulation input. These audio and modulation signals are perfectly compatible with each other, 
the only difference being that the audio signals are “audible” of you connect them directly to the 
VCA, while the modulation signals are generally not audible (as the frequency is too low for the 
human ear). Modulation signals are generally used to program “slow” variations on certain synthesis 
settings, like the filter cut-off frequency for example. 

• The audio output and input connectors, and the modulation out connectors are rep-
resented differently in the graphical interface: 

 

Audio input connector 

• Additional modulation input connectors can be found on the tracking module lo-
cated under the grid of the right loud speaker. They are graphically distinguished 
from the other connectors as they include an additional function: the modulation 
level setting, described later on in this chapter: 

 

Modulation input connector 

To connect the output of a module to the input of another module, click on the output and, while 
holding the mouse button depressed, drag the mouse to the input connector of the second module. 
When you pass over a connector on which the current cable can be placed, the connector will light 
up. In this case, when you release the mouse button, the connection will be created between the 
selected input and output. 

 

 

Creation of a new connection by drag and drop 

Another way is to right click (on Mac: click while holding down the shift key) on the input or output 
of a module. In this case, a menu appears with a list of possible connection points for this in-
put/output. It can happen that the input/output will already be connected to certain modules; in 
this case the connection points already in use will appear in this menu. Simply choose a connection 
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point in the “Connect to” menu to create a connection. It is also possible to delete the curent con-
nection by choosing the “Remove connection” option.  

 

 

 

Right click for input/output connection menu (or Shift + click) 

4.3.2 Modifying a connection 

To disconnect a cable from an input connector, and reconnect it to another, click on the end of the 
cable and hold the mouse button down. You can now use the mouse to drag the cable to another 
input and release the button. 

To delete a connection, you can right click and use the menu (or Shift + click). It is also possible to 
click on the cable to be removed to select it. The cable will appear in a lighter color to indicate 
that it is selected. Then simply press the “DEL” key to delete the connection. 

that it is selected. Then simply press the “DEL” key to delete the connection. 

4.3.3 Setting the level of modulation 

As explained above, the modulation input connectors have an interesting property: they allow the 
setting of the level of modulation (from –100% to +100%) directly at connector level, and thus avoid 

Remark: Each modulation input can only receive one connection, but each output connector 
can be connected to any number of inputs. This allows us to use one modulation signal on sev-
eral synthesis settings. 

Remark: You will have trouble selecting a cable if the “Move away cables” option is active !! In this 
mode, the cables automatically avoid the mouse pointer. To avoid this, deactivate this option be-
fore trying to select a cable (see. 1.4.4.3) 
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the need to use a VCA which would normally be necessary to set the amplitude of the modulation 
signal. When the modulation input connector is connected, click on one of the edges of the jack’s 
hex nut and drag the mouse up or down to change the depth of modulation: 

 

Setting the quantity of modulation 

 

4.3.4 Separate the cables 

Visualizing the existing connections between different modules is very useful when creating a patch 
on the ARP2600 V. At the same time, the cables can sometimes hide access to some of the settings 
available on the modules. So as not to be hindered in your manipulations, it can be useful to acti-
vate the “Move away cables” mode. In this mode, the cables will automatically avoid the mouse 
pointer, leaving you with a clearer view to checking or modifying potentiometer values. Don’t for-
get to deactivate this mode when you want to select a cable with the mouse! 

 

Deactivate the “separate the cables” mode 

4.3.5 Virtual keyboard 

The keyboard lets you listen to the synthesizer sounds without the need for an external master MIDI 
keyboard, and without programming a melody in the sequencer. Just click on a virtual key to hear 
the corresponding sound.  

 
 

By right clicking (or Shift + click) instead of the left click, you will obtain a more precise setting. 

Attention: If you click on the centre of the connector, you will select the cable end to change the 
connection. To access the modulation setting, make sure you click on the nut. In the same way, if 
you right click (or Shift + click) on the centre of the connector, you will reach the connection 
menu instead of the precise modulation quantity setting. 
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4.3.6 MIDI control 

 

Most of the knobs, sliders and switches on the ARP2600 V can be manipulated with external MIDI 
controllers. Before anything else, make sure that the MIDI device that you wish to use is correctly 
connected to the computer, and that the sequencer or the ARP2600 V application is correctly con-
figured to receive MIDI events coming from the device. 

Every instance of the ARP2600 V receives MIDI events transmitted on a given channel. This reception 
channel is defined in a global manner for the synthesizer, either in your sequencer, or in the stand-
alone ARP2600 V application. On the reception channel, the ARP2600 V can receive up to 120 dif-
ferent MIDI controls. It is possible to choose a reception control for each knob. For this, click on the 
knob that you wish to control while holding down the Control key. A configuration window appears 
and will allow you to choose a MIDI control number. You can also click on the “Learn” button and 
move one of your physical MIDI controllers. In this case, the control number will be detected and 
configured automatically. To deactivate the MIDI control of a knob, simply uncheck the “Active” 
option in the MIDI control window. 

 

 

MIDI configuration of a knob 
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5 The modules 

The ARP2600 V can be separated into 3 parts: from top to bottom, the first is a cabinet dedicated to 
sound programming and effects, the second concerns the ARP sequencer and the playing mode con-
figuration interface with the keyboard and LFO, and finally the third contains the keyboard. 

5.1 Sound programming cabinet 

5.1.1 Description 

 

The programming section groups all modules which can be used to program sounds. It is also in this 
screen where the different patches needed in the programming of a sound are made. 

It is sometimes necessary to connect a module in the programming section to a module located in 
the sequencer section.  

The sound programming section contains: 

3 oscillators, which can also be used as sources of modulation. (VCO) 

1 multimode filter. (VCF) 

1 amplifier (VCA) 

2 envelopes dedicated to modulations 

1 noise generator  

1 ring modulator 

1 envelope follower 

1 sample and hold 

2 mixers (on the filter and the VCA) 

1 electronic switch 

A tracking generator module 

5 mixer / lag module 

2 effects (chorus / delay) 
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5.1.2 The Oscillators (Oscillators - VCO) 

There are three oscillators in the ARP2600.  

The oscillators permit the management of the base frequency and tone of the ARP 2600. It also 
manages the impulse width of the wave forms. These changes can either be made with linear poten-
tiometers, or thanks to modulation inputs which can be connected to the output of any module (en-
velope, low frequency oscillator - LFO -, modulation wheel…).  

The oscillators can also be tuned and modulated separately with the potentiometers and a range 
selector. These oscillators supply up to 4 wave forms that can be used simultaneously. 

These 3 oscillators, tuned separately and providing mixed wave forms, quickly give us very rich 
sounds. The tone can also be easily modified with modulation inputs.  

 

The 3 oscillators settings 

5.1.2.1 Oscillator 1 
Range : General tuning of the oscillator by octaves. Up or down 4 octaves and low fre-
quencies 

Frequency : Tuning by semi-tone (Initial Oscillator Frequency). Up or down 2 octaves 
Fine tuning : Fine tune up or down by up to a semi-tone 

Audio outputs : Output sawtooth & square wave form connection jacks 

Sync : Synchronization of oscillator1 with 2, 3, or 2 and 3 

FM Inputs : Frequency modulation input connection jacks 

• Key follow : pre-cabled for the manual setting of the (KYBD CV) 
• Sample and hold : pre-cabled for the manual setting of the modula-

tion by sample and hold (S/H out) 
• ADSR Env : pre-cabled for the manual setting of the modula-

tion by ADSR envelope ADSR 
• Oscillator 2 Sin : pre-cabled for the manual setting of the modula-

tion by sine wave form of oscillator 2 (VCO2 Sin) 
 

 

5.1.2.2 Oscillator 2 
Range  : General tuning of the oscillator by octaves. Up or down 4 octaves and low frequen-
cies 

Frequency : Tuning by semi-tone (Initial Oscillator Frequency). Up or down 2 octaves 

Fine tuning : Fine tune up or down by up to a semi-tone  



ARTURIA – ARP2600 V – USER’S MANUAL 37 

Audio outputs : Connection jacks for 4 wave form outputs: triangle, sine, saw-tooth and square 

Impulse width : Impulse width for “Sawtooth”, “Square”, “Triangle” wave forms 

FM Inputs : connection jack for frequency modulation inputs 

 

• Key follow : pre-cabled for manual setting of the key follow 
(KYBD CV) 

• ADSR Env : pre-cabled for the manual setting of modulation by 
ADSR envelope 

• Sample and hold : pre-cabled for the manual setting of modulation by 
sample and hold (S/H out) 

• Square oscillator 1  : pre-cabled for the manual setting of modulation by 
the square wave form of oscillator1 (VCO1 square) 

• Noise : pre-cabled for the manual setting of modulation of   
the impulse width of the square by the noise (PWM _ 
noise out) 

 

 

5.1.2.3 Oscillator 3 
Range : General tuning of the oscillator by octaves. Up or down 4 octaves and low fre-

quencies 

Frequency  : Tuning by semi-tone (Initial Oscillator Frequency). Up or down 2 octaves 
Fine tuning : Fine tune on up or down by up to a semi-tone 

Audio output : Audio output connection jacks for the sawtooth and square wave forms 

 

Impulse width : Impulse width of the “Square” signal 

FM Inputs  : Frequency modulation input connection jacks: 

• Key follow (KYBD CV) : pre-cabled for the manual setting of the key follow  
• Noise(Noise) : pre-cabled for the manual setting of the modula-

tion by the noise 
• ADSR Env : pre-cabled for the manual setting of the modula-

tion by ADSR envelope 
• Sine oscillator 2 (VCO1 sin) : pre-cabled for the manual setting of the modula-

tion by the sine wave form of oscillator 2  
• triangle oscillator2 : pre-cabled for the manual setting of the modula-

tion of the impulse width of the square by the oscil-
lator2 triangle (Pulse width modulation _ VCO2 Tri-
angle) 

 

� The general tuning of the 3 oscillators is done with the “VCO Initial frequency” potentiometer 
by +- one octave per semi-tone.  

� For fine tuning, set the Fine tune potentiometer to +/- one semi-tone.   
� Depending on the position of the “Range” selector switch, the range is of +/- 4 octaves. It is 

also possible to set it to low frequency position (LF – for low frequency). You will no longer hear 
any sound, but can now use it as LFO source of modulation. 

� The impulse width applied to the “sawtooth”, “triangle” and “square” wave forms of oscillators 
2 and 3, can be modified with the “pulse width” potentiometer. 

 

Oscillator 1 possesses two audio outputs for the sawtooth and square wave forms. These can be 
used simultaneously. The second and third oscillators possess four outputs for the sawtooth, sine, 
triangle and square. 

The frequency modulation inputs (FM Control) and Pulse Width Modulation allow the control of 
these parameters thanks to the outputs of other modules (an envelope, a LFO for example) They are 
all pre-cabled to a defined module in advance by the developer of the ARP 2600V. This is to simplify 
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the use of the synthesizer. For example: the frequency of oscillator 1 can be modulated, from the 
left to the right, by the key follow, the sample and hold, the ADSR envelope and the oscillator 2 
sine. In low frequency position (LF), the oscillators perform modulation using the lower CPU power 
compared to the other positions. 

 

� To set the modulation rate, use the linear potentiometer situated above the corresponding 
jack. 

� You can also connect another source of modulation to each input. This considerably widens the 
possibilities for sound creation.  

Here are graphical representations of the different wave forms used by ARP 2600V oscillators: 

 

Sawtooth 

 

Square 

 

Triangle 

For a conventional key follow setting (in relation to the scale) place the potentiometer completely 
to the top. 
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Sine 

5.1.3 The Filter (Filter - VCF) 

The ARP2600 V possesses a multimode filter module (the original had only one resonant low pass 
mode). It is possible to choose a filter type among the five offered: a low pass 24 dB (identical to 
that found on the ARP2600), a low pass, a high pass, a band-pass and a notch 12 dB of the same kind 
as the one found on the ARP 2500 modulars. The change of type is done by setting the selector situ-
ated on the right of the filter module.  

 

 

The filter settings 

As with the oscillators, the filter possesses audio connections (a mixer) and internal modulation 
inputs allowing the simplification of its use.  

Frequency (Initial Filter Frequency)  : Sets the filter cut-off frequency, tuned between 10 
Hz and 10 KHz 

Fine tuning  (Fine tune)    : Fine tuning of the filter cut-off frequency 

Resonance      : Sets the filter resonance 

Notch frequency / fc  (Notch Frequency/ fc) : Sets the frequency of the notch divided by the 
filter cut-off frequency 

Filter type selector  (Types)    : Type of filter (LP 2600 and 2500, HP, BP and notch) 

Audio output  (Output)    : Filter audio output connection jacks 

Audio input  (Audio) : Filter input connection jacks (initially connected to 
the ring modulator, to the oscillators1 and 2 square, 
oscillator3 sawtooth and noise) 

Modulation inputs (Control)   : Filter frequency modulation input connection jacks.   
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• Key follow (KYBD CV) : Pre-cabled for the manual setting of the key follow   
• Oscillator3 sine (VCO3 Sin) :pre-cabled for the manual setting of the modulation  

by sine wave form of oscillator2 
• ADSR Env  : re-cabled for the manual setting of the modulation 

by ADSR envelope. 

 

It possesses a cut-off frequency setting and a resonance setting. 

A setting separated from the notch filter frequency (Notch frequency) divided by the initial filter 
cut-off frequency has been added. This very particular parameter (present on the module of the 
ARP2500) transforms the notch filter to a low shell or high shell filter.  

As for all other modulation inputs, once connected, its amplitude is set by raising the linear poten-
tiometer.  With a right click, we obtain a higher level of precision. Receiving a modulation coming 
directly from the output of a generator (envelope, oscillator, sequencer), the maximum amplitude 
of modulation of +/- 9 octaves. 

Only the cut-off frequency can be dynamically modulated by one of the 3 modulation inputs.  

5.1.3.1 The filter types: 

• The low pass 24dB / oct Low pass (LP 24) 
The low pass 24dB filter is typical of the ARP2600. It eliminates the frequencies situated below the 
pivotal frequency (the cut-off frequency).  

 

 

The low pass filter 

The four other filtering modes didn’t exist on the original ARP2600 but existed on the ARP2500 
modular systems. They all use a filtering slope at 12 dB/ octave. These modes were added to in-
crease the possibilities for sound creation on the ARP 2600V. 

• The low pass 12dB / octave (LP 12) 
The low pass 12 dB filter is works in the same manner as the 24 dB/ oct. on the the ARP2600. It will 
just give you a slightly different result due to the fact that its filtering slope is not as fast. 

• The high pass (HP 12) 
The high pass filter is the opposite of the low pass filter. It eliminates the frequencies above the 
cut-off frequency. 

For a conventional key follow setting (in relation to the scale) place the potentiometer com-
pletely to the top. 
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The high pass filter 

• The band pass filter (BP 12) 
The band pass filter is a combination of the low pass and high pass: It eliminates the frequencies on 
each side of the cut-off frequency. 

 

The band pass filter 

• The notch filter (Notch) 
The notch filter coupe is the opposite of the band pass filter. It eliminates the frequency band situ-
ated on both sides of the cut-off frequency. 

The resonance can be used to accentuate the “hollow” of this frequency band. 

 

The notch filter 

Attention! if you raise the resonance too high, the result of the filtering will no longer be heard 
as the frequency band will be too big to allow efficient filtering. 
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5.1.4 The envelopes 

Two in number, the modulation envelopes allow the evolution of the sound in relation to the time.  

The first envelope (ADSR) possesses four temporal periods which are performed sequentially: the 
Attack time, Decay time, Sustain voltage and the Release time. When the trigger input moves to 
active state (triggering of a note), the envelope performs the sequences “Attack” followed by “De-
cay” and remains in the “hold” state (Sustain) as long as the input trigger remains active. When it 
goes to the inactive state (release of the note), the envelope performs the “fall” sequence (Re-
lease). 

 

ADSR and AR envelopes settings 

5.1.4.1 ADSR 
 
Attack (Attack time)  : Sets the attack time  

Decay (Decay time)  : Sets the decay time  

Hold (Sustain Voltage)  : Sets the level of the hold  

Release (Release time)  : Sets the release time  

Output (Output)  : Envelope output signal 
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5.1.4.2 AR 
 

Attack (Attack time)  : Sets the attack time  

Release (Release time)  : Sets the release time 

 

5.1.4.3 Trigger modes 
 
Trigg input (S/H gate) : Input connection for an external trigger 

signal (pre-cabled to the Sample and Hold 
clock) 

“Gate” output type (Gate)  : Output connection for a “gate” type sig-
nal: for every note played on the keyboard, 
the signal remains active as long as the note 
is held down. 

 

“Trigger” output type (trig)  : Output connection for a “trigger” type 
signal: each note played by the keyboard 
presents a sustain time reduced to the 
minimum. 

Switch “trigger by Sample and Hold clock” (S/H gate): Selection of the choice of envelope trigger 
- AR and ADSR – by the keyboard or Sample 
and Hold clock. This function reactivates 
the envelopes at every clock cycle. 

 

5.1.5 Output amplifiers (Voltage Control Amplifier - VCA) 

The amplifier is the last step in the conception of a preset. It sets the general volume of the sound.  

 

the VCA settings 

This module is very simple; it contains: 

Gain (Initial Gain)   : Sets the general synthesizer volume  

Audio input (Audio VCF / ring mod)  : Audio input connection jack (pre-cabled to the filter and 
ring mod audio outputs). 
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Modulation inputs (Control) : Modulation input connection jacks (pre-cabled on the AR 
and ADSR envelopes).   

5.1.6 Noise Generator 

The noise generator generates white noise or colored noise. It possesses a low pass filter to dampen 
high pitched frequencies. 

 

the noise generator 

Low pass frequency (white / Low Freq)  : Sets the cut-off frequency of the low pass 
filter.  

Noise volume       : Sets the noise volume. 

Noise generator output (Noise generator output)  : Noise out connection jack. 

 

5.1.7 Voltage processor (Mixer / inverter / lag generator)  

The voltage processor allows you to mix up to 8 inputs (audio or modulation) to one (or several) 
outputs. 

It also allows you to invert the input signal – a positive-going modulation (an envelope for example) 
will thus become negative. 

A lag generator allows you to smooth an input signal. For example, the square signal from a LFO 
approximates a triangle the more we raise the potentiometer value, increasing the lag time. 

 

 

the voltage processor 

8 signal inputs (input)    : Audio or modulation signal input connection jacks. 

4 balance (mix)    : Sets the balance between the two input signals 

4 inverters (inverter)   : Inverts the input signal 

4 lag generators   : Smoothes the input signal 
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4 signal outputs (output)  : Audio or modulation signal output connection jacks 

4 “Mix” switches : This switch allows you to merge one or several inputs pairs 
into the one above. 

4 “volume” potentiometer : potentiometer to set the volume of 2 input signals (A                   
and B for example)  

 

5.1.8 Sample and Hold generator 

 

This module lets you sample the signal connected as input. The source can be external (source of 
trigger connected to the input) or pre-cabled to the noise generator. This module allows you to 
create random modulations by sampling the noise signal, for example. 

You can also connect an external clock source to pilot the sample and hold speed (the wave form 
output of an oscillator for example). 

 

 

the sample and hold settings 

 
Level (Level)     : Sets the Sample & Hold modulation level. 

Rate (Rate)    : Sets the Sample & Hold clock speed.  

External Input (“Noise gen”)   : Audio or modulation external signal input connection jack. 
(pre-cabled to the noise module) 

Sample and Hold output  : Sample and Hold output connection jack 

Internal clock output (Int Clock out)  : Sample and Hold internal clock output connection jack 

External clock input (Ext Clock in)  : External clock input connection jack 

MIDI Synchronization (MIDI sync) : Selector switch for the synchronization of the clock to a 
MIDI sequencer. 

5.1.9 The”electronic switch” module (Electronic switch) 

The “Electronic switch” module allows you to alternate the two sources connected to inputs A and B 
depending on the speed of the clock connected (pre-cabled to the Sample and Hold clock) to create 
a composite source of modulation.  
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the electronic switch 

An example: 

� Connect the output of the square wave form of oscillator 1 to input A and the sine output of 
oscillator 2 to input B.  

� Place these two oscillators to low frequency position (LF) so as to slow the oscillation speed. Set 
the frequency potentiometers for the two oscillators to 0.3 Hz.  

� Connect output C of the interrupter to one of the filter modulation inputs. 
� Set the Sample and Hold clock speed potentiometer towards the bottom to clearly hear the 

alternation between the two modulations.  
 

Inputs (A / B)     : Audio or modulation signal input connection jacks. 

 

Selector switch (C) : Selector switch C connection jacks between signals A and 
B 

External clock input (Ext clock In) : External; clock connection jacks (pre-cabled to the Sample 
and Hold clock) 

5.1.10  Envelope follower 

 

The envelope follower allows the generation of a modulation from an external (or internal) source 
of audio signal. The (Pre amp.) volume parameter sets the fineness of the envelope follow. The 
lower it is, the more closely the variations of the input signal will be followed. 

 

 

the preamplifier 
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The envelope follower 

An example: 

� Try for example to insert an audio signal coming from a drum loop sample to the input of the 
envelope follower. 

� Connect the output of the envelope follower to one of the filter modulation inputs. 
� Increase the modulation rate for the amp (VCA). 
� Do the same for the envelope follow level. The VCA volume will modulate the volume of the 

VCA with the envelope of the drum loop audio sample. 
 

Audio input (Pre-Amp)  : Envelope follower audio input connection 
jack 

Output (Output)     : output jack fo the audio signal  

Level (Level)  : Sets the amount level of the envelope fol-
lower  

Gate out (gate out)     : Trigger signal output connection jacks 

5.1.11  Ring modulator 

 

The ring modulator is a module which allows you to multiply two signals in order to generate non-
harmonic frequency components. It is useful for creating metallic sounds. 

 

 

the ring modulator 

2 Audio inputs (VCO1 Saw / VCO2 Sin) : Audio input connection jacks (pre-cabled to the 
oscillator1 sawtooth and oscillator 2 sine outputs). 

Output (Output)    : Ring modulator output connection jacks 
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5.1.12  “Tracking” generator 

 

This very original module was added to modify the course of a modulation thanks to four curves 
which can be edited in real-time by the user. It can also be used as source of modulation to create 
envelope forms or complex LFO waves. 

 

 

the tracking generator’s main interface 

• Main interface: 
4 audio inputs    : Audio input signal connection jacks. 

4 modulation inputs   : modulation input signal connection jacks 

4 audio outputs   : Audio signal input connection jacks. 

4 “Smooth”    : Sets the smoothness of the tracking curve. 

4 Edit     : Button for opening the tracking curve edit mode. 

• Edit interface 

 
 

Curve editing screen   : Screen for real-time curve editing. 

Drawing tool     : Tool for drawing a freehand curve. 

Line tool     : Tool for drawing a straight line. 

Curve tool     : Tool for drawing an exponential curve. 
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Sine tool     : Tool for drawing a sinusoid. 

Square tool     : Tool for drawing a square signal. 

Noise tool     : Tool for adding noise to an existing signal. 

Eraser tool     : Tool for erasing an existing signal. 

Undo / Redo    : To undo or redo a drawn signal.  

 

A few tips for using it: 

� To create an exponential curve: Firstly click on the editing screen to place the starting curve for 
the curve. 

� Drag (without releasing) to draw the curve. 
� Click and drag up or down to set the amplitude. 
� Click once again to validate this curve. 

5.1.13  Reverberation 

This module lets us add reverberation to the sound. 

 

 

the reverb module 

Right effect level (Level)   : Sets the output level for the right reverberation 

Left effect level (Level)   : Sets the output level for the left reverberation 

Right output (Output R) : Right output connection jack (with or without re-
verberation) 

Left output (Output L) : Left output connection jack (with or without re-
verberation) 

Dry input right (Dry input right)  : Dry right input connection jack 

Dry input left (Dry input Left)   : Dry left input connection jack 

5.1.14 Chorus and delay effects 

Chorus has three potentiometers, “Rate” “Depth” and “Dry/Wet” which allow us to respectively set 
the speed, the depth and the relation between the original and modified signals.  
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The chorus effect 

Delay has two potentiometers, “Time Left” and “Time Right”, respectively for setting the time for 
the left channel, and the right channel. The two potentiometers, “FeedB Left” and “FeedB Right” 
respectively set the channel return gain for left and right channels. Finally the “Dry/Wet” potenti-
ometer sets the ratio between the original and modified signals. 

 

The delay effect 

The “Midi Sync” selector switch allows us to synchronize the return time for the delay to the tempo 
of the host application. 

5.1.15 Control voltages (CV control) 

These modulation outputs allow us to control the synthesizer parameters with the real-time control-
lers of your MIDI keyboard. 

 

the CV controls 

Pitch bend wheel (Pitch bend)  : Output connection jack for the control of modu-
lation of three oscillators with the pitch bend 
wheel. 

Modulation wheel (Mod Wheel)  : Output connection jack for modulation control 
with the help of the modulation wheel. 

Velocity (Velocity) : Output connection jack for velocity control. 

After Touch : Output connection jack for After Touch control. 

Key follow outputs x1 and x 4 (KYBD CV output) : Output connection jacks for key follow x 1 (tem-
pered key follow) and x 4 
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5.2 Keyboard interface (Model 3620) 

The keyboard interface contains all of the parameters necessary for playing on a keyboard: the 
monophonic or polyphonic playing modes, the portamento, the LFO (mainly used for vibrato), key-
board triggering modes, etc... 

 

the keyboard interface 

Portamento trigger input pedal (portamento footswitch) : Output connection jack for portamento 
trigger control with a pedal. 

Sustain trigger input pedal (KBd Latch)  : input connection jack for Hold trigger 
control with a pedal. 

Play mode selector (Modes) : Selection of keyboard play mode - 
monophonic, unison, polyphonic.  

Detune polyphonic voices (Unison detune) : Sets the detuning of the voices in “uni-
son” mode. 

Select trigger modes (Trigger modes) : Selects trigger mode for keyboard 
notes: legato / retrig  

Pitch Bend  : Simultaneously sets the frequency of 
the three oscillators. 

Global tuning (Global tune) : Simultaneously set the global tuning of 
the three oscillators 

5.3 Low frequency oscillator (LFO) 

The use or a low frequency oscillator as source of modulation is quite common. It allows us to make 
the tone of a sound evolve gently or to create a vibrato or tremolo effect. 

Even though three oscillators can be used at very low frequencies, there is a specific module for 
this, allowing you to dedicate the oscillators to generation in the audible domain. 
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the LFO 

Low frequency oscillator speed (LFO speed) : Sets the clock speed for the low frequency 
oscillator. 

Low frequency oscillator delay (LFO delay) : Sets the delay of the low frequency      
oscillator action. 

Vibrato depth (vibrato depth)    : Sets the depth of the vibrato. 

MIDI synchronization (MIDI sync) : The “Midi Sync” selector switch lets you 
synchronize the low frequency oscillator 
clock with the MIDI tempo. 

Triangle output (LFO triangle)    : Audio output of the LFO triangle wave 
form. 

Square output (LFO Square)    : Audio output of the LFO square wave form. 

Sawtooth output (LFO Saw) : Audio output of the LFO sawtooth wave 
form. 

Sine output (LFO Sine)     : Audio output of the LFO sinusoid wave form 

External vibrato input (LFO External Vibrato in) : Audio input for external LFO source. 

5.4 The ARP sequencer 

This module was born of the original ARP sequencer model 1601 (18). It was one of the most widely 
used sequencers in the 70’s and early 80’s. 

With this module, you will create melodic sequences or step by step variations applied to synthe-
sizer parameters (a sequence line applied to the opening of the frequency of a filter can be very 
effective, for example). 
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• Sequence step management, setting and management of the 16 sequencer steps 
 

 
 

2x 8 output levels (1 ... 16 faders) : Sets the modulation or tuning level for sequence 
steps. 

Bus 1, 2 and 3 (switches Gate bus 1, 2, 3)  : Trigger selector switch for steps by bus 1, 2 or 3 

Bus inputs1, 2 and 3 (inputs Gate bus 1,2,3) : Input jacks for bus 1, 2 or 3 

Position     : Position input jacks  

Sequencer clock output(Clocked gate out)  : Sequencer clock output jack 

• Sequencer oscillator  
 

 

the sequencer oscillator 

Skip / return ( Skip/Off/reset Steps)  : Selector switch for skipping steps or returning to 
step 1 

Skip steps (Step)    : Button for manual choice of steps. 

Return input (Reset)    : Input jack for a forced return to step 1. 

Start input (trig or gate) (jack Start) : Input jack to start the sequencer with a trig or 
gate signal. 

Trig or Gate (trig / gate) : Selector switch for choice of trig or gate (starting 
the sequencer). 

Start / stop (Start / Stop)  : Button for manual starting / stopping of the sequencer. 

Start / stop jack (Start / Stop jack) : Input jack for sequencer start / stop. 

Start / stop pedal (Start / Stop pedal) : Pedal to start and stop the sequencer. 

Clock frequency (Clock Freq)  : Sets the sequencer clock speed 

Clock frequency output (Clock out)  : Input jack for the sequencer clock output. 

 

Clock FM (FM)    : Sets the modulation rate for the clock frequency. 

FM input (Clock FM)  : Jack input for the modulation of the clock frequency (ini-
tially connected to the “gate” input) 

Impulse modulation (Pulse width)  : Sets the rate of modulation for the signal impulse width. 

 

16 sequencer 
steps and bus 
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PW input (PWM)  : Jack input for the modulation of the impulse width of the 
signal. 

• Setting the sequencer input / outputs (quantizer) 
 

 

the sequencer input / outputs 

Quantized outputs A and B (Quantized outputs A/B)  : Output jacks A and B for the quanti-
zation of the step signals in semi 
tones. 

CV input (CV input)  : Jack inputs manage the reference 
voltage for the sequencer (generally 
connected to CV keyboard control - 
Kybd CV output) 

Quantized inputs A and B (Quantized inputs A/B) : Input jacks A and B for the signal 
quantization. 

Non quantized outputs A and B (Sequencer outputs A/B) : Output jacks A and B non quantized 
(continuous values to +/- 4 octaves) 
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6 The basics of subtractive synthesis 

Of all forms of sound synthesis, subtractive synthesis is one of the oldest and still certainly one of 
the most employed today. It is this method that was developed toward the end of the 60’s on ana-
log synthesizers like the ARP, Moog, Oberheim, Yamaha, Buchla, Sequential Circuits (Prophet se-
ries), Roland, Korg (MS and PS series) and many others. This concept of synthesis is still used on 
most current digital synthesizers, complementing sample reading or wave tables, which progres-
sively replaced the analog oscillators of the first synthesizers in the 80’s. The ARP2600, or even your 
own ARP2600 V are among the best illustrations of the enormous possibilities of subtractive synthe-
sis. 

6.1  The three main elements 

6.1.1 The oscillator or VCO 

The oscillator (Voltage Controlled Oscillator) is the starting module (with the noise module which is 
often classed among the oscillators) for the creation of a sound on an analog system.  

It will generate the initial sound signal. We can think of the oscillator like a violin string that once 
stroked or plucked, vibrates to create its sound. 

 

The oscillator settings on the ARP2600 V 

The main oscillator settings are: 

� The pitch is determined by the oscillation frequency. You can set the frequency of the oscilla-
tor with 2 controllers: first, the “RANGE” selector which determines the fundamental frequency 
– it is expressed in feet- : Low, 32,16,8,4,2 ; the highest number (32) brings the deepest tone, 
inversely, the smallest number (2) brings the highest tone. – Secondly, the detune setting 
(“FREQUENCY”) lets you tune the oscillator more precisely. 

� The waveform which determines the harmonic richness of the audio signal. On the ARP2600 V, 
four waveforms are available: 

 

• The saw tooth presents the richest audio signal of the four waveforms (it contains 
all of the harmonics at decreasing volume levels in high frequencies). Its sound is 
ideal for brass sounds, percussive bass sounds or rich accompaniments. 
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• The square possesses a more “hollow” sound that the saw tooth (it only contains 
odd harmonics) but none the less, its rich sound (notably in low frequencies) can be 
used for sub-bass sounds that will come out well in the mix (the square oscillator is 
often set an octave below that of the saw tooth), wood sounds (clarinet, if the 
square signal is a little filtered), etc.… 

 

 

• The triangle can be considered like a very filtered (and soft) square signal. It is very 
low in harmonics (odd only) and will be very useful for creating sub basses, flute 
sounds, etc.… 
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� The sinusoid is the purest of all. It is a single harmonic and produced a very “damped” sound. It 

can be used to reinforce the low frequencies of a bass sound or as a frequency modulator in or-
der to create harmonics that don’t exist in the original waveforms.  

 
PWM (Pulse Width Modulation) is a setting that allows you to modify the waveform cycle (or wave 
length). This can be done manually with the help of a knob “PW” or by modulation (with an enve-
lope or LFO). This pulse width variation translates to a spectrum modification, resembling a wave-
form change. 

 

The ARP2600 V waveforms on the oscillator2 

The synchronization of an oscillator with another creates more complex waveforms. If for example, 
you synchronize oscillator2 with oscillator1, oscillator2 will restart a new period every time the first 
oscillator completes a period, even if oscillator2 has not completed a complete period (this signifies 
that it is not tuned to the same tonality!) The more you tune oscillator2 upwards, the more you will 
encounter composite waveforms.  
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In the above image, oscillator2 is synchronized with the first and tuned to twice its frequency. The resulting 
waveform is unique in that it cannot be created by standard synthesis techniques such as layering or filtering. 
 

A frequency modulation (FM) can be created between 2 oscillators by connecting the audio output 
from a first sinusoidal oscillator to the modulation input of a second oscillator. On the ARP2600 V, if 
you turn the modulation rate ring, you will obtain a sound richer in harmonics. If you introduce a 
square or saw tooth signal, the result can be quickly distorted… but interesting for inharmonic so-
norities like bell sounds or special effects for example.   

 
The noise module  

The noise signal spectrum has all frequencies at an equal volume level, often referred to as “white 
noise”. For this reason, the noise module is used to create different noises like the imitation of 
wind or special effects. White noise is the richest of noises. Pink noise is also regularly present on 
synthesizers. It is less rich in the high frequencies than white noise.  

Also note that the audio output of noise can also be used as a modulation signal (especially when 
strongly filtered) to create random cyclic variations. 
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the ARP2600 V noise module 

6.1.2 The filter or VCF 

The audio signal generated by an oscillator (the waveform) is next generally directed to a filter 
module (Voltage Controlled Filter). It is this module that we use to control the sound by filtering 
(by subtraction, which explains the name given to this type of synthesis) the harmonics situated 
around a cut-off frequency. It can be considered to be a sophisticated equalizer that reduces, de-
pending on the case, the high or low frequencies of a sound. 

The removal of undesirable frequencies at the cut-off frequency is not done suddenly but progres-
sively, depending on the filtering slope. This filtering slope is expressed in decibels per octave (or 
dB/Oct). The filters used in classic analog synthesizers have 24 dB/Oct or 12 dB/Oct slopes. 

 

the ARP2600 V filter module 

The ARP 2600 V offers two types of slope: 24 and 12 dB/Oct slopes. 

 
 

On the ARP2600 V, you have access to four types of filtering. Let’s have a look at some of his prop-
erties: 

• The low-pass filter (LPF) progressively removes high frequencies above the assigned 
frequency limit (the cut-off frequency) and allows the sound below the cut-off to 
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pass through unchanged. Depending on the setting we will hear the sound becoming 
more or less “brilliant”, more or less “dampened”.   

 

This is the type of filtering that you will find more often than not on synthesizers that use subtrac-
tive synthesis. It can be found on most of the recent analog and digital synthesizers. 

 

Spectrum of a noise signal proceed with a low-pass filter 
 

• The high-pass (high-pass filter or HPF), as opposed to the low-pass, eliminates low 
frequencies and only allows high frequencies past. The sound will thus become 
“thinner”. It is very useful for removing redundant low frequencies. 

 
 

• The band-pass (band-pass filter or BPF) eliminates the frequencies situated on ei-
ther side of the cut-off frequency. Use it to make a certain band of frequencies that 
you wish to emphasize appear. This will make the sound more “pinched”.  
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• The band-reject (band-reject filter or notch) eliminates the frequencies inside a 
band of frequencies. This filter is above all else interesting when we want to vary 
this band of frequencies (with the “frequency” on the ARP2600 V filters or the 
modulation of an LFO on this same parameter). You will thus obtain a sound close to 
a “phasing” effect. 

 
 

These four types of filtering are often used on analog synthesizers.  

A second setting to compliment the cut-off frequency: the resonance. 

(you will also find it called “emphasis” or “Q” – for Quality of filtering) 

The resonance amplifies frequencies close to the cut-off frequency. The other frequencies remain-
ing are either unchanged (below the cut-off frequency) or reduced (above the cut-off frequency). 

On the ARP2600 V, you can increase the rate of resonance through the “resonance” potentiometer. 

When you increase the resonance, the filter becomes more selective, the cut-off frequency is am-
plified, and the sound begins to “whistle” at the cut-off frequency. 
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With a high resonance level, the filter will begin to produce a sound close to a sine waveform. At 
this stage, the use of a key follow is very important as you can create a melody by tuning the cut-
off frequency of the filter along with the frequency of the oscillators. 

6.1.3 The amplifier or VCA    

The amplifier (Voltage Controlled Amplifier) is charged with receiving the audio signal coming from 
the filter (or directly the one from the oscillator if it is not filtered) to adjust its volume with a 
potentiometer, before the signal is directed to the speakers.   

 

 

the ARP 2600V amplifier 

In conclusion, here is a scheme that may help you to understand the composition of a basic sound: 

 

6.2 Complementary modules  

6.2.1 The keyboard 

If we hold down a key at this stage, the sound you will get from the speaker will be uniform, with-
out life and without end! In fact, the oscillator delivers a continuous signal (the audio output of a 
wave form) of a fixed pitch. The only means of stopping this sound that quickly becomes unsupport-
able is by lowering the filter cut-off frequency so that it becomes more and more thick until it dis-
appears; or more simply, to lower the volume of the amplifier!  

• To trigger and stop this sound, at the tone that we want, we use a keyboard, which 
will be connected to the oscillator. This will “play” as soon as a key is pressed and 
will mute it as soon as released. Of course, this connection is made through MIDI (it 
replaces the “gate” type connection of analog synthesizers, which triggers the 
sound when the key is pressed and stops when released). 

• In the second case, so that the sound is correctly tuned with the keyboard notes, we 
need to apply a key follow modulation (replacing the 1Volt/octave control present 
on most analog synthesizers). 
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If you don’t have a keyboard, you can play on the ARP2600 V virtual keyboard. 

 

the virtual keyboard of the ARP2600 V 

6.2.2 The envelope generator.  

The envelope generator, connected to the amplifier, is used to “sculpt” the form of a sound during 
a cycle, which begins when we press a note on the keyboard, and ends when we release. 

 

the envelope module  

The most common envelope modules use 4 settings that we can vary:  

• The Attack is the time that the sound will take to reach its maximum volume once 
the key has been pressed on the keyboard. 

• The Decay is the time that the sound will take to decline after the key is played. 
• The Sustain is the maximum level of volume that the sound will reach when a key is 

pressed. 
• The Release is the decline time after the key has been released. 
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The ARP 2600 V also offers a second simplified envelope (Attack, Release). 

The envelope generator can also be used to modulate other settings, like the filter cut-off fre-
quency or the frequency of an oscillator for example. 

6.2.3 The low frequency oscillator. 

The LFO (Low Frequency Oscillator) possesses, among other things, the same characteristics as the 
classic audio-frequency oscillator but does not produce frequencies higher than 20 Hz. In other 
terms, you won’t hear the sound if you connect the audio output of an LFO in an amplifier. 
Not being used to produce a sound, it can be used to create a cyclic modulation on the parameter 
on which it is connected. 

On the ARP2600 V,the  LFO module is situated on the left of the sequencer . 

 

the LFO module of the ARP2600 V 

For example:  

� If you connect an LFO to the modulation input of an amplifier, the sound volume will increase 
and decrease in an alternate manner depending on the speed (the frequency) of this LFO. This 
will create a tremolo effect. 

� To produce a vibrato effect, simply connect the sinusoid output of an LFO to the modulation 
input of an oscillator. The frequency of this oscillator will thus be modulated up and then down. 

� Finally, try to connect an LFO output to the modulation input of a lightly resonant low-pass 
filter and you will obtain a “wah wah” effect. 
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VCA modulated by a LFO 

6.2.4 The ring modulator  

The ring modulator is a module which multiplies two signals (generally two oscillators) so as to gen-
erate non-harmonic frequential components. We can thus easily obtain metallic sounds. 

 

the ring modulator of the ARP2600 V 

6.2.5 Sample and hold 

The sample and hold module lets us sample the signal connected as input. The values for modula-
tion are taken at every trigger signal connected as input. 

This module is notably interesting for creating random modulations by sampling the noise signal.  

It is also possible to use it for more rhythmic cyclic modulations by connecting a square or saw-
tooth wave form coming from a VCO to the sample and hold input. 
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the sample and hold module of the ARP2600 V 

Now to finish, the scheme of a full synthesizer containing: 

• 3 oscillators (VCO) 
• 1 noise module  
• 1 ring modulator  
• 1 sample and hold 
• 2 mixers (mix of the 3 VCO, noise and ring modulator towards the filter and the 

VCA) 
• 1 filter (VCF) 
• 1 amplifier (VCA, can be placed in stereo space with the pan potentiometers) 
• 1 envelope ADSR 
• 1 envelope AR 
 

 

The famous sound of R2D2 in Star Wars was created with the sample and hold module on the 
ARP2600!  
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7 A few elements of sound design 

Here is a series of five examples designed to guide you through the creation of a sound and a se-
quence. They are classed in order of difficulty and organized into two parts: 

• The first part will give you an introduction to sound synthesis. For this you will start 
with the most simple patch (make a VCO oscillator “ring” in a VCA amp going 
through the filter) and finish by programming of a richer sound (several sources of 
VCO, VCF filter, VCA,  envelopes…) 

• The second will take you through every aspect of the sequencer 

7.1 Simple patch without cabling 

To begin, we will look at programming an elementary monophonic sound. It will be composed of 
four modules:  

• two oscillators (VCO1 and 2)  
• a low-pass filter (VCF) 
• an amplifier (VCA)  
• the ADSR envelope connected to the filter 

 

You will thus obtain a basic patch for subtractive synthesis. 

Figure 1 shows the different potentiometer positions: 

 
 

To begin, choose the preset “Temp/ Blank” in the “Template” / “Temp_Synth” bank. You will no-
tice that no sound is heard when you play a note. Don’t worry, this is normal! Only the volume of 
the VCA amplifier mixer (the VCF filter output) and the ADSR envelope input of the VCA are open. 

� On the filter module, raise the vertical “VCO1” potentiometer. This is the volume of the first 
oscillator. When you hold down a note, the sound seems continuous and flat! 
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raise the “VCO1” potentiometer on the filter module 

� To give it more life, still on the same module, raise the “ADSR” potentiometer corresponding to 
the envelope of the same name. 

 

raise the “ADSR” potentiometer 

� Lower the filter cut-off frequency (“Initial Filter Frequency”) potentiometer almost completely 
so as to really hear the effect produced by the envelope on the filter. 

 

Lower the filter cut-off frequency 

� Lower fully the Sustain potentiometer on the ADSR envelope and lower the Decay a bit as well. 
(set a value aroud 100ms). The duration of the sound becomes shorter. 
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lower the Decay potentiometer 

� Now raise the volume of “VCO2” on the VCF mixer (“VCO2”). You will hear the 2 oscillators play 
in unison.   

 

raise the volume of VCO2 

� Lightly detune the second oscillator (“VCO2”). The sound becomes more lively and “fatter” ! 

 

Lightly detune the second oscillator 

� Set the VCO2 an octave lower: set the “Range” octave selector to “16’”. 

 

set the “Range” octave selector to “16’” 

� Finally, lightly raise the filter resonance. This will give you a typical 70’s bass sound ! 
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raise the filter resonance  

7.2 Polyphonic patch with cabling 

Let’s reuse the sound “bass1” as it will be useful to us for the next preset. 

We will see how to surpass the limits of the pre-cabled (internal connections between the modules 
don’t need cables). Thanks to this method, you will discover the richness of the ARP2600V. 

This preset contains: 

• three oscillators (VCO1, 2 and 3)  
• a low pass filter (VCF) 
• an amplifier (VCA)  
• the ADSR envelope connected to the filter 
• the AR envelope connected to the amplifier 
• a LFO connected to the filter 

� Drag a cable from the saw-tooth output on oscillator1 to an audio input of the filter mixer. For 
this click on the VCO1 “Saw” output and direct the mouse to the “VCO1 square” audio input on 
the VCF mixer.  

 

direct the “Saw” output to the “VCO1 square” audio input on the VCF mixer 

� Still on this mixer, lower the VCO2 volume. You will notice the change of tone resulting from 
the change of wave form on VCO1. If you need to be convinced, disconnect the cable (click on 
the mixer audio input to disconnect the cable). You thus move from a saw-tooth to a square sig-
nal. Reconnect the saw-tooth to continue with this preset. 

� Do the same with oscillator2: direct the saw-tooth wave form to the VCO2 input on the VCF 
mixer. 

Save this sound as “bass1”, you can reuse it later on. For this, click on the “Save_as” button and 
choose the option “new bank” (at the bottom of the menu). Provide a new name to the bank 
(your initials for example), the sub-bank (“basses” for example) and to the new preset (“Bass1” 
for example). 
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� Still on the same mixer, raise the volume of oscillator3 to complete the base tone. You will hear 
a sound composed of three oscillators.  

 

raise the volume of oscillator3 

� Let’s apply a variation to the filter cut-off frequency with the LFO. For this, connect the sinus 
wave form of the “LFO” module (on the left of the “ARP sequencer”) to the “control VCO2 sin” 
modulation input on the VCF. Raise the volume potentiometer for this modulation. The filter 
cut-off frequency will vary in a cyclic manner. 

 

raise the volume of the LFO modulation 
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� If it has a tendency to “disappear” too much (you don’t hear any more sound), gently raise the 
cut-off frequency potentiometer. 

� Set the LFO oscillation speed with the “LFO Speed” potentiometer. For this type of sound 
choose a slow speed (around 0.10 Hz).  

 

set the LFO oscillation speed 

� Raise the Attack time (“A” around 2000 ms) and the Release (“R” around 750ms) of the AR en-
velope. At last, raise fully the Decay time (“D”) of the ADSR envelope. These types of envelopes 
go better with accompaniment sounds. 

 

The envelopes settings 

� Set the playing mode selector situated on the left of the LFO module to “Poly” (polyphonic) 
position so as to be able to play chords. Then choose the number of polyphonic voices by click-
ing on the “voices” button, situated on the toolbar. (For exemple, choose “6” voices) 
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polyphonic mode 

� At this stage, you can also enrich your chords by dedicating a third oscillator to sevenths (“+7 
semi-tones”) - or fifths (“+5 semi-tones”). 

 

set the third oscillator to sevenths 

� If you wish to bring more space to your sound, add a delay or chorus effect to it. For this, click 
on the “Chorus” or “Delay” buttons situated on the toolbar, open the grid on the left of the syn-
thesizer. This holds the settings for these 2 effects. If you use delay, you can synchronize it with 
the MIDI tempo of your host sequencer.  

 

the “Chorus” and “Delay” settings 

� Don’t forget to save your new sound, as like the previous, it will be useful as a template for 
other more complicated sounds. 

7.3 Special effects patch with the help of the tracking generator 

With this example, you will discover a few of the many possibilities for modulation with the tracking 
generator / LFO. This module is one of the major additions to the ARP2600 V compared to the origi-
nal. 
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Let’s again use the “bass1” sound as template for the following preset: 

• two oscillators (VCO1 and 2)  
• a low pass filter (VCF) 
• an amplifier (VCA)  
• the tracking generator connected to the filter 

 

We will first see how to create a “complex LFO” modulation type on the filter cut-off frequency 
with the help of the tracking generator. 

� On the tracking generator module (situated on the bottom right of the synthesizer section), 
click on the “open tracking” button under this grid to open it. Then, connect the output of the 
first tracking line ( “out”) to the “VCO2 Sin” modulation input of the filter. 

 

open the tracking grid... 

 

... then, connect the output of the first tracking line to the filter modulation input 

� Raise the potentiometer above the modulation input jack. This is the modulation rate. 

 

the modulation rate 
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� Next click on the “edit” button for this tracking line. A secondary window appears. It will allow 
you to graphically draw the wave form that will modulate the cut-off frequency. 

 

click on the “edit” button 

� It is composed of three parts: on the left, the selection of the 4 tracking lines, in the middle, 
the interface for drawing the wave form, and above, the choice of drawing tools. 

 
� By default, the “pencil” tool is selected. Start by drawing a freehand curve. The form is not 

important. Once this is done, play a note to hear the result of this modulation. You can set the 
oscillation speed with the “Freq” potentiometer which is on the left of the tracking generator. 

 

drawing a freehand curve 



76 ARTURIA – ARP2600 V – USER’S MANUAL 

� If you wish to modify your curve, return to the editing screen to make changes. The modifica-
tion is directly taken into account as soon as you click on the edit screen. Nothing stops you 
from creating several types of curves (freehand, curve, sinus, square, noise…) on a single line. 
To do this just use the appropriate tool. 

 
� You can combine the four tracking lines for a single modulation input. For this, Connect the four 

tracking  generator outputs to the “voltage processor” 1, 2, 3 and 4 inputs. 

 

Connect the 4 tracking  generator outputs to the “voltage processor” inputs 

� Place the “link A/B” selector switch to the right to link the two lines of mix to the output of the 
first. 

 

Place the “link A/B” selector switch to the right 

� Of course, the more tracking lines you combine and send to the same destination, the more 
difficult it becomes to master and hear. 

 

 

7.4 Patch using the sequencer to create a melody 

The ARP sequencer model 1601 was one of the most frequently used sequencers of its time (the 
70’s). It was added to the ARP2600 V to increase the possibilities for creating melodies and sounds.  

The next two examples show how to use the ARP sequencer to create a melody and a sequence of 
modulation of a synthesis parameter. 

For these 2 examples, return to the “bass1” preset. It presents the ideal sound for a melodic se-
quence or for applying a modulation sequence to the filter cut-off frequency.   

 

�  So that your sequence is tuned by following the semi-tones, connect the “Quantized output A” 
on the sequencer to the input oscillator1 key follow (“VCO1” > “CV KBD”).  

The “CV input” is connected directly to the key follow which allows is to trigger a sequence 
tuned to the note played. The sequencer will automatically start when you play a note. 
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connect the “Quantized output A” of the sequencer to the KBD CV input oscillator1 

� Play a note on your keyboard (C4 for example). The sequencer starts and you will hear a series 
of 16 notes of identical pitch, this is normal.  

� Set each of these 16 potentiometers representing 16 sequence steps to a different value. This 
will be the melody played in a loop. 

 

16 sequence steps to a different value 

� You can stop the sequencer by clicking on the “Start/Stop” button.  
 

 

stop the sequencer by clicking on the Start/Stop” button 

It is possible to obtain a sequence of 16 steps like the one you have just created by using 2 inde-
pendent sequences of 8 steps. For an 8 step sequence, place the “1/16 > 2/8” selector switch to 
2/8. The sequencer will only play half of the sequence. 
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2 independent sequences of 8 steps 

 

To play the steps randomly 

7.5 Patch using the sequencer to create a modulation sequence 

Let’s look at creating a sequence of modulation on the filter cut-off frequency. 

This will be very useful, notably for special effects such as a “techno” sequence. 

Reuse the previous example as a template for this exercise (if you have not created it, go directly 
to the next step). 

� Connect the sequencer B output to the second modulation input acting on the filter cut-off fre-
quency (ADSR). Raise the potentiometer of the same name to increase the depth of this modula-
tion.  

To play the 16 (or 8) steps randomly, switch the “sequential / random” selector switch to the 
right (“random”) 
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Connect the sequencer B output to the second modulation input of the filter... 

 

...and raise the modulation potentiometer 

� Play a note on your keyboard to start the sequencer. Change the positions of the 16 potenti-
ometers representing 16 steps in the sequence.  You can hear the variations on the opening of 
the filter cut-off frequency. This creates an automatic wah wah effect. 

� It is also possible to simultaneously create a melodic sequence on the eight first steps and a 
modulation sequence on the last eight. For this, set the “1/16 > 2/8” interrupter to 2/8. The 
sequencer will only play half of the sequence.  

 

It is of course possible to connect any other ARP parameter to the sequencer, like the amplifier 
volume (VCA) for example, the change of wave form width for oscillator square wave form, etc… 
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These different examples were of varying difficulty. We hope that they will have helped you get to 
know some of the possibilities offered by the ARP2600V. But don’t hesitate in making your own at-
tempts at programming; this is the best way to progress and find a certain originality. 
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8 Using the ARP2600 V in different modes 

8.1 Stand-alone 

The ARP2600 V application can be used as an instrument independent of a sequencer (stand alone 
mode). It allows you to open one or several instruments, and to play with a master MIDI keyboard. 

8.1.1 Launching the application 

To launch the ARP2600 V application from Windows, go to Start > Arturia > ARP2600 V and choose 
ARP2600 V . 

On Macintosh, open the installation folder and double click on the ARP2600 V application icon. 

You can also double click on a saved document in order to open the corresponding configuration in 
the ARP2600 V application.  

8.1.2 Setting preferences 

The preferences window allows you to set the global preferences in the ARP2600 V application. 
These settings are automatically saved. 

To display the preferences window go to the File > Preferences menu on Windows and ARP2600 V  
> Preferences on Mac. 

 

 

The preferences window 

Attention! The ARP2600 V application is only available for Windows 2000/ XP and Mac OS X 
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The Macintosh preferences window 

• Protocol (Windows only): Select the audio protocol that you want to use. If you have 
ASIO drivers for your sound card, it is highly recommended that you use them in-
stead of DirectX protocol; the ASIO drivers provide a higher performance rate in re-
lation to the DirectX driver. 

• Driver: Select the driver corresponding to the sound card that you want to use. 
• Sample rate: Here choose a sample frequency among those offered by your sound 

card.  
• Latency: Here you can set the optimal audio latency in relation to the performance 

of your sound card and your system. Attention: a latency set too low may cause oc-
casional jumps, clicks, or pops in the sound. 

• Potentiometer mode: Here choose the instrument potentiometer control mode.  

8.1.3 The control bar 

Each instrument has a control bar setting the routing of MIDI events as input, and sound as output. 

 

The Windows control bar 

 

The Macintosh control bar 

8.1.3.1 Configuration of MIDI routing 
The first section of the tool bar is for selecting the MIDI input that will be applied to the instru-
ment.  

Choose the MIDI port to which the keyboard that you are using to control the instrument is con-
nected, and the channel that you wish to use. You can choose to respond to one or all of the chan-
nels of this MIDI port by selecting ‘All’ in the MIDI channel choice. 

8.1.3.2 Configuration of the keyboard zone 
The keyboard zone allows you to use only a section of the keyboard to control the instrument. In 
this manner, you can play several instruments on the same keyboard, each instrument responding to 
a different zone. 

To activate this function, check the ‘zone’ option in the tool bar. You can then limit the keyboard 
zone by setting the lowest and highest note to be applied to this instrument. 
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8.1.3.3 Configuration of the octave 
The octave allows you to transpose the notes of your keyboard by one or several octaves. This func-
tion is interesting if your keyboard doesn’t cover the octave in which you wish to play or if you have 
activated the keyboard zone option. 

8.1.3.4 Configuration of the audio input and output 
The two last parts of the toolbar are used to select the audio channel on which you wish to play this 
instrument, and the one that will provide audio data. 

If the selected soundcard has several audio outputs, respectively audio inputs, you will find those 
available in this list. Just choose the pair of outputs or inputs that you desire. 

8.1.4 Information on the level of processor use 

The processor usage gauge allows you to control the level of processor consumed by the sound syn-
thesis in real time.  

On Windows, this gauge is directly visible in the instrument tool bar.  

On Mac, you can display it by choosing Window > Cpu in the application menu or from the shortcut 
+ L. 

 

8.1.5 Saving an instrument 

 
Saving allows you to save the state of an instrument, that is to say its sound settings, as well as the 
audio and MIDI configuration. 
To save a configuration, just select File > Save or File > Save as … to save the configuration under a 
new name. 

 

8.2 VST™  

8.2.1 Installation 

8.2.1.1 For Windows  

• During the installation, check the “VST” option among the choice of plug-in formats 
offered. The installer will automatically detect the VST instruments folder used by 
your version of Cubase. In the case of another VST compatible sequencer, like Logic 
Audio for example, you might need to manually copy the plug-in file to the appro-
priate folder. You can find this file after the installation in the folder “C:\Program 
Files\Arturia\ARP2600 V\VSTPlugin”. The file is called “ARP2600 V.dll”. 

8.2.1.2 For Mac OS X 
During the installation, check the “VST” option among the choice of plug-in formats offered. The 
VST plug-in will be automatically installed in the system folder corresponding to the VST instru-
ments, and can be used by VST applications of the type host. 

Attention: this information only comprises the processor load corresponding to the sound synthesis; 
it is therefore less than the global system load. 

Attention: if saving a configuration in the ARP2600 V application saves the sound settings of the 
instrument, this has nothing to do with the saving of the presets of the instrument itself (cf. 4.1.3 
Saving a user preset). The saving in the application does not imply the saving of the current preset. 
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8.2.2 Using the instrument in VST mode 

Opening the ARP2600 V VST plug-in is done like any other VST plug-in; please consult the user man-
ual of the host sequencer for more information. For Cubase SX, open the menu “Devices / VST In-
struments”, and choose ARP2600 V in the rack: 

 

Opening the ARP2600 V in Cubase SX on PC 

8.2.3 Connection to a MIDI track 

So that the ARP2600 V can play the information coming from a MIDI track, you must choose a MIDI 
track and select the ARP2600 V as the MIDI output for this track using the menu in Cubase which is 
used for this: 

 

Connection of a MIDI track to the ARP2600 V 

The events played on a MIDI keyboard are then transmitted by your sequencer to the ARP2600 V. It 
is of course possible to record these MIDI events, and use all of the sequencer’s MIDI editing possi-
bilities. 

8.2.4 Saving presets 

When the session is recorded, the state of the ARP2600 V is recorded as is, even if the programming 
does not correspond to any preset. For example, if you were working on preset “P1” on which you 
had modified the parameters (without having saved them under the name “P2”), the next time the 
song is opened, the ARP2600 V will load preset “P1” with the modifications. 

The drop-down menu offered by the VST sequencer to save plug-in settings can of course be used 
with the ARP2600 V. Nevertheless, it is strongly recommended that you use the internal ARP2600 V 
menu: the presets saved in this manner can be used in any other mode (standalone or other se-
quencer), and can be exported as a distinct and separate file. 
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8.2.5 Automation 

Automation works with the ARP2600 V as like any other VST plug-in (refer to the VST sequencer 
documentation for more information on the automation of plug-ins). Preset changing (and therefore 
cable changing) cannot be automated. 

8.3 Pro Tools™  

8.3.1 Installation 

During the initial installation, select Install as a RTAS/HTDM plug-in. 

Then, when you are asked, indicate the folder in which the other RTAS and HTDM plug-ins are pla-
ced. Generally the path is: 

• for Mac OSX: System Folder/DAE Folder/Plug-Ins 
• for Windows: C:\Program Files\Common Files\Digidesign\DAE\Plug-Ins 
• If your system can or cannot use the HTDM plug-ins or not (see the next section), 

the installation is the same. 
 

8.3.2 The RTAS and HTDM standards 

The ARP2600 V can function with the audio Digidesign Audio Engine (DAE) in two ways: 

• As a RTAS plug-in (Real Time Audio Suite).  
• All of the Pro Tools systems are compatible with this standard: the audio treatment 

is realized entirely by the central unit, and does not require any specific extension 
card (TDM system type). On the TDM systems, the RTAS plug-ins can only be loaded 
on an audio track before the TDM plug-ins. They can only be loaded on an Aux Input 
or a Master Fader. 

• As a HTDM plug-in (Host Time Division Multiplexing). 
• Only the TDM systems  (with at least one extension card) under Mac OS X can use 

these plug-ins (refer to Digidesign for the future HTDM compatibility with Windows). 
The latter work exactly like TDM plug-ins (no limitations in the insertion positions, 
etc…), with the difference that in this case, the heart of the treatment is realized 
by the central unit, and not by the extension cards. 

• The advantage of this standard is the subtlety of TDM, and this, loading at least the 
DSP of the cards. 

 

Recap of the compatibilities:   

 Mac OSX Windows XP 
TDM System        

      
RTAS and HTDM 

(stereo in/stereo out) 
RTAS 

(stereo in/stereo out) 
Other Systems 

(Pro Tools LE, Free) 
RTAS (mono in/stereo out and 

stereo in/stereo out) 
RTAS (mono in/stereo out and 

stereo in/stereo out) 
 

8.3.3 Opening the instrument 

Access to the ARP2600 V plug-in is done like any other plug-in, through for example an audio track 
insert: 
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• TDM systems: the ARP2600 V must be loaded on an audio stereo track. Opening it as 
a HTDM plug-in is done through the TDM sub menu, as a HTDM plug-in is used ex-
actly like a TDM plug-in. 

• Other systems: the ARP2600 V can be loaded on a mono audio track (which becomes 
stereo after the insertion) or stereo.  

• You can play the ARP2600 V with the mouse or the virtual keyboard. 
 

8.3.4 Connection to a MIDI node 

So that the ARP2600 V can play the information coming from a MIDI track, we must associate it with 
the MIDI node of the latter through the appropriate menu: 

We can also control the ARP2600 V through a command keyboard (see the Pro Tools manual for the 
connection of this type of device). 

8.3.5 Saving presets 

Once the session is saved, the state of the ARP2600 V is saved as it is, even if the programming does 
not correspond to any preset. For example, if you had been working on a preset P for which you had 
modified parameters (without having saved them under the name P), the next time the song is 
opened, the ARP2600 V will load preset P with the modifications. 

The “Librarian Menu” of Pro Tools can of course be used with the ARP2600 V like any other plug-in. 
Nevertheless, it is recommended that you prioritize the internal menu of the ARP2600 V, and this 
for several reasons: 

• The saved presets can be used in any sequencer, notably making user exchanges 
easier. 

• They are compatible with the different versions of the ARP2600 V that will appear 
with its evolution. 
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8.3.6 Automation under Pro Tools 

Automation functions with the ARP2600 V like any RTAS/HTDM plug-in (refer to the Pro Tools docu-
mentation for more details on plug-in automation). Preset changes (and thus cable movements) 
cannot be automated.  

8.4 DXi™ 

The ARP2600 V is compatible with the DXi protocol, and so can be used notably with Sonar, but also 
with any other sequencer that accepts DXi instruments. 

8.4.1 Installation 

During the installation, check the “DXi” box among the list of protocols that you wish to activate for 
the ARP2600 V on your computer, then simply follow the on-screen instructions until the installation 
is complete. Once the installation has finished, the ARP2600 V can be used as a DXi instrument. 

8.4.2 Opening the instrument (SONAR™ 2.0) 

In the “Insert” menu, open the “DXi Synth” sub-menu, and choose the ARP2600 V. 

 

Opening the DXi instrument 

• The “Synth Rack” then appears. To make the ARP2600 V graphical interface appear, 
double-click on its name in the “Synth Rack” window. 

8.4.3 Connection to a MIDI track 

So that the ARP2600 V can play the information coming from a MIDI track, you must choose a MIDI 
track and select the ARP2600 V as the MIDI output for this track using the menu in Sonar which is 
used for this: 
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Connecting a MIDI track to the ARP2600 V 

The events played on a MIDI keyboard are then transmitted by your Sonar to the ARP2600 V. It is of 
course possible to record these MIDI events, and use all of the Sonar MIDI editing possibilities. 

8.4.4 Saving presets 

When the session is recorded, the state of the ARP2600 V is recorded as is, even if the programming 
does not correspond to any preset. For example, if you were working on preset “P1” on which you 
had modified the parameters (without having saved them under the name “P2”), the next time the 
song is opened, the ARP2600 V will load preset “P1” with the modifications. 

8.4.5 Automation 

Automation with Sonar functions simply by the reception and recording of Control Change type MIDI 
messages. You can configure the ARP2600 V MIDI message reception just as you do in standalone 
mode. The sequencer takes care of recording the continuous control transmitted to the ARP2600 V, 
and allows you to edit them. 

8.5 Audio Unit 

8.5.1 Installation 

Audio Unit plugins are automatically installed in “/Library/Audio/Plug-Ins/Component”. 

8.5.2 Using the plugin in Logic Audio 

8.5.2.1 Adding an instrument 
Select an instrument track. On corresponding the mixing table slice clic on the “I/O” button to get 
the plugins list, and select “Stereo -> AU Instruments -> Arturia -> ARP  2600 V”. 
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Adding an instrument in Logic Audio 

8.5.2.2 Adding an effect 
In the mixing table slice you wish to add an effect to, click on “Effect” to get the effects list, and 
then select “Stereo -> Audio Instruments -> Arturia -> ARP2600 V Efx”.  

  

Adding an effect in Logic Audio 

Since version 7, Logic has an AU Manager. To launch it, click on “Preferences -> Start Logic AU Man-
ager”. 
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Starting Logic’s AU Manager 

This manager lets you see the list of available plugins, test their compatibility with Logic, and acti-
vate or deactivate them. 

If one of your plugins is creating problems in Logic, check that it has passed the compatibility test 
and that it is enabled. 

 

The AU Manager 

8.5.3 Using the plugin in Digital Performer  

8.5.3.1 Adding an instrument 
Clic on the menu item “Project -> Add Track -> Instrument Track -> ARP 2600 V”.  
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Loading a new instrument 

Once you have added this instrument, you can redirect a midi track toward it. In the connections 
menu of the midi track, select the instrument as well as the midi channel. 

 
 
 

  

sélection du canal MIDI 

8.5.3.2 Adding an effect 
You can insert the ARP2600 V Efx effect on an audio track or another instrument track. To do that, 
just click on the effect menu of the corresponding mixing table slice, and select “Arturia -> 
ARP2600V Efx”. 
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Selecting the AR2600 V Efx 
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AARRTTUURRIIAA  AARRPP22660000  VV  --  LLIICCEENNSSEE  AAGGRREEEEMMEENNTT  
 
 
Grant of License 
In consideration of payment of the Licensee fee, which is a portion of the price you paid, Arturia, as Licensor, 
grants to you, the Licensee, a nonexclusive right to use this copy of the ARP2600 V program (hereinafter the 
“SOFTWARE”) on a single computer. All rights not expressly granted to Licensee are reserved to Arturia.  
 
Software Ownership 
As the Licensee you own the disks on which the SOFTWARE is recorded or fixed. Arturia shall retain full and 
complete title to the SOFTWARE recorded on the enclosed disks and all subsequent copies of the SOFTWARE, 
regardless of the media or form on or in which the original disks or copies may exist. This License is not a sale 
of the original SOFTWARE. 
 
Copyright Restrictions 
This SOFTWARE and the accompanying printed or written materials are copyrighted. Unauthorized copying of 
the SOFTWARE, including those instances where the SOFTWARE has been modified, merged, or included with 
other Software, or of the printed or written materials, for any reason, is expressly forbidden. Licensee may be 
held liable for copyright infringement which results from such unauthorized copying. 
 
Restrictions on Use 
Licensee may physically transfer the SOFTWARE from one computer to another, provided that the SOFTWARE is 
used on only one computer at any one time. Licensee may not electronically transfer the SOFTWARE to multi-
ple computers over a network system. Licensee may not distribute copies of the SOFTWARE or accompanying 
materials to others. Licensee may not modify, adapt, translate, reverse engineer, decompile, disassemble, or 
create derivative works based on the SOFTWARE or it's accompanying printed or written materials. 
 
Transfer Restrictions 
Licensee shall not assign, rent, lease, sell, sublicense or otherwise transfer the SOFTWARE to another party 
without prior written consent of Arturia. Any party authorized by Arturia to receive the SOFTWARE must agree 
to be bound by the terms and conditions of this Agreement. 
 
LIMITED WARRANTY AND DISCLAIMER 
 
Limited Warranty 
Arturia warrants that the disks on which the SOFTWARE is furnished to be free from defects in materials and 
workmanship under normal use for a period of thirty (30) days from the date of purchase. Your receipt shall be 
evidence of the date of purchase. Any implied warranties on the SOFTWARE are limited to thirty (30) days from 
the date of purchase. Some states do not allow limitations on duration of an implied warranty, so the above 
limitation may not apply to you. All programs and accompanying materials are provided “as is” without war-
ranty of any kind. The complete risk as to the quality and performance of the programs is with you. Should the 
program prove defective, you assume the entire cost of all necessary servicing, repair or correction. 
 
Remedies 
Arturia's entire liability and your exclusive remedy shall be at Arturia's option either (a) return of the purchase 
price or (b) replacement of the disk that does not meet the Limited Warranty and which is returned to Arturia 
with a copy of your receipt. This limited Warranty is void if failure of the SOFTWARE has resulted from acci-
dent, abuse, modification, or misapplication. Any replacement software will be warranted for the remainder of 
the original warranty period or thirty (30) days, whichever is longer. 
 
No other Warranties 
The above warranties are in lieu of all other warranties, expressed or implied, including but not limited to, the 
implied warranties of merchantability and fitness for a particular purpose. No oral or written information or 
advice given by Arturia, its dealers, distributors, agents or employees shall create a warranty or in any way 
increase the scope of this limited warranty. 
 
No Liability for Consequential Damages 
Neither Arturia nor anyone else involved in the creation, production, or delivery of this product shall be liable 
for any direct, indirect, consequential, or incidental damages arising out of  the use of, or inability to use this 
product (including without limitation, damages for loss of business profits, business interruption, loss of busi-
ness information and the like) even if Arturia was previously advised of the possibility of such damages. Some 
states do not allow limitations on the length of an implied warranty or the exclusion or limitation of incidental 
or consequential damages, so the above limitation or exclusions may not apply to you. This warranty gives you 
specific legal rights, and you may also have other rights which vary from state to state. 
 


